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Patents 

The technique of using a wall-mounted scanner to capture a 

photographic side profile of a human face, which is then used to 

create a 3D relief in ArtCAM, is subject to a patent. 

Patent No: GB 2 387 731 "Deriving a model from a scan of an 

object" 

The functionality of preparing a 3D relief of the side profile of a 

human face direct from a photograph in ArtCAM is subject to a 

patent. 

Patent No: GB 2 403 883 "Photo to 3D" 

The functionality of the 3D layers used to design and machine an 

article in ArtCAM is subject to a patent application. 

Patent No: GB 2 434 287 "3D Layers" 

The functionality of creating a low relief from an imported 3D object 
in ArtCAM without losing low-level detail is subject to a patent. 

Patent No: GB 2 455 966 "Method and System for Generating 
Low Reliefs – a.k.a. Scan to Low Relief" 

The functionality of filling an area with geometric or natural textures 
using pattern elements and a controlling direction line in ArtCAM is 
subject to a patent application. 

Patent Application: GB 2492225 "Texture Flow" 

The Support structure functionality is subject to patent applications. 

Patent application: US 14325878 Method for calculating support 
structures and support elements for attaching a support strut of 
same 

Patent application: GER 10 2013 011 630.9 Method for 

calculating support structures and support elements for attaching 
a support strut of same 
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ArtCAM 2015 R2 offers all the original features of ArtCAM 2015, but 
with numerous improvements. This document describes the most 
significant improvements.  

Visit the website at http://www.artcam.com/ for the latest news and 
videos. 

 
 

What's New in ArtCAM 
2015 R2 
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Summary of new features 
ArtCAM 2015 R2 contains the following new features and 

enhancements. 

In all variants of ArtCAM: 

 3D-printing reliefs (see page 16) — You can prepare reliefs for 

3D-printing. 

 Using the Draw Bitmap Line tool (see page 41) — You can now use 

this tool in the 3D View window. 

 Identifying snap points (see page 42) — There is a new Snap Hints 

option on the View > Snapping menu that enables you to identify 

potential snap points.  

 Changing the thickness of vectors (see page 43) — You can 

change the thickness of vectors in both the 2D and 3D View 

windows. 

 Creating fillets (see page 44) — There are three new fillet types 

available from the Tool Settings: Fillet Vectors panel. 

 Exporting true geometry (see page 45) — You can now export 

circles as true circles instead of as Beziérs and arcs.  

 Merging vector layers (see page 46) — You can merge multiple 

vector layers that are selected in the Project Tree.  

 Importing and exporting vectors (see page 48) — There are new 
import and export options available from the Vector Layers panel 

and Vector item context menus. 

 Preserving vector colour information (see page 51) — Use the new 
Split colours into separate layers option to control how ArtCAM 

imports coloured vectors. 

 Using rulers in the 3D View window (see page 53) — There are 

now rulers in the 3D View window.  

 Interactively editing the Z height of relief clipart (see page 55) — A 

new control arrow enables you to adjust the Z height of relief 
clipart when the Transform tool is open. 

 Searching the libraries (see page 68) — There is a new search 

field in the Relief Clipart Library panel, Component Library panel, 

and Vector Library panel. 

 Selecting multiple toolpaths (see page 72) — You can select 

multiple toolpaths from different parent groups.  

 Simulating toolpaths (see page 74) — Toolpath simulation is now 

much faster 
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 Miscellaneous changes (see page 74) — There are several small 

changes to ArtCAM.  

In ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only: 

 Exporting relief slices to .dxf (see page 55) — You can export 

relief slices as .dxf files.  

 Live Weave tool (see page 63) — The Tool Settings: Weave Tool 

panel replaces the Weave Wizard dialog, and the tool now works 

in real-time. 

 Creating constant height letters (see page 67) — You can create 

constant height lettering using the Shape Editor panel.  

In ArtCAM Pro and ArtCAM Jewelsmith only: 

 Working with assemblies (see page 4) — There are several 

changes to the way in which you can work with assemblies. 

 3D-printing assemblies (see page 18) — You can prepare 

assemblies for 3D-printing. 

 Creating relief layer groups (see page 54) — You can create relief 
layer groups in the Front Relief and Back Relief layer stack.  

 Sharing your Relief Height Analysis settings (see page 56) — You 

can share your relief height analysis settings between 
workstations.  

 Texture Flow tool update (see page 57) — You can choose to keep 

the generated texture relief clipart as relief clipart rather than 
pasting it directly onto the active relief layer. 

 Live Contour Blend tool (see page 66) — The relief updates in 

real-time so you can instantly see results. 

 Controlling the direction of the offset in 3D Offset strategies (see 

page 70) — You can now whether to start offsetting from the 

inside or the outside of the clearance area.  

 Setting a threshold for surface links in 3D Offset and Constant Z 

strategies (see page 71) — There is a new Surface Links option 

when you are creating 3DOffset, 3DOffset Spiral, or Constant-Z 

finishing strategies. 

In ArtCAM Jewelsmith only: 

 Live Two Rail Ring Sweep (see page 61) — The relief updates in 

real-time when you use the Two Rail Ring Sweep tool. 
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Working with assemblies 
In ArtCAM Pro and ArtCAM Jewelsmith, there are several changes to 

the way in which you can work with assemblies: 

 The appearance of the panels (see page 4) is improved. 

 You can now group assembly items (see page 9). 

 The behaviour of the Lay On Surface (see page 9)  tool is 

updated. 

 There are three new tools:  

  Create New 3D Print Job (see page 18). 

  Batch Assembly (see page 10). 

  Transform (see page 6). 
 



 

ArtCAM 2015 R2 What's New What's New in ArtCAM 2015 R2 • 5  

Changes to the mesh, gem, and assembly panels 

In ArtCAM Pro and ArtCAM Jewelsmith, there are changes to the 

layout of the panels when you are working with assemblies.  

On mesh, gem, and assembly panels: 

 There is a new Transform (see page 6)  option. 

 Section headers no longer fold up and down when you click 

them. 

On mesh and assembly panels: 

 There is a new Dimensions area. The top row of the Dimensions 

area displays the combined dimensions of all visible and hidden 

meshes within an assembly, or the dimensions of a selected 
mesh. The bottom row of the Dimensions area, labelled Visible, 

displays the dimensions of the visible parts of a selected 
assembly. 

 

On assembly panels: 

 The Properties area of the panel is removed. The Edit Object 

Attributes  and Edit Object Shading  buttons are now 

in the Tools area of the panel. 

 There is a new Children area, which contains the options that 

create children of an Assembly item in the Project Tree. 

 The Libraries area is removed. The Component Library button is in 

the new Children area.  

 There are two new options:  

  Batch Assembly (see page 10). 

  Create New 3D Print Job (see page 18). 
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Assembly transform 

There is a new Transform  button in the Positioning area of the 

assembly, mesh, and gem panels. This option enables you to 

interactively move, rotate, and scale the selected assembly 

component, mesh, or gem item using the control handles that are 
displayed in the 3D View window. 

When you have an assembly, a mesh, or a gem selected, click 

Transform  to display the transform settings below the splitter 

bar. The settings change depending on which action is selected. 

Transform settings with 

Nudge selected: 

 

Transform settings with 

Scale selected: 
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The following settings are available: 

Action — Select the transform action you want to perform. 

  Nudge — Click to enter nudge mode. In the View window, a 

bounding box with control handles is drawn around the item. Use 
Nudge to move the selected object around the View window. 

 

 — Drag this handle to rotate the item about the X axis. 

 — Drag this handle to rotate the item about the Y axis. 

 — Drag this handle to rotate the item about the Z axis. 

 — Drag this handle to move the item along the X axis. 

 — Drag this handle to move the item along the Y axis. 

 — Drag this handle to move the item along the Z axis. 
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  Scale — Click to enter scale mode. In the View window, a 

bounding box with control handles is drawn around the item. Use 
Scale to resize the selected object. 

 

 — Drag this handle to scale the item along the X axis. 

 — Drag this handle to scale the item along the Y axis. 

 — Drag this handle to scale the item along the Z axis. 

 — Drag this handle to scale the item in all directions. 

Move — Enter values in the X, Y, and Z fields, then click Apply to 

move the selected item an exact distance. This area is available 
only if you are in nudge mode. 

Rotate — Select an axis and choose a direction, then enter a degree 

value in the field to rotate the selected item by an exact amount. 
This area is available only if you are in nudge mode. 

Scale — Enter values in the Width, Height, or Z Range fields to scale 

the selected item by an exact amount. This area is available only if 

you are in scale mode. 

   Maintain Aspect Ratio — When selected ( ), the 

proportions of the selected item are preserved. When deselected 

( ), the proportions are not preserved. 

 Scale in — Select whether to set the selected item's size in length 

units or as percentage of the original size.  

Transform Relative To — Select whether to transform the selected 

item relative to the World Centre or the Component Centre.  
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Grouping assembly items 

Assemblies often contain many items and sub-assemblies. You can 

group an assembly so that when you click any of its 
sub-components in the View window, it selects the grouped 

assembly. This makes it easier to select the correct item in the View 

window and perform operations on it. 

 

The  icon is displayed in the Project Tree beside grouped 

assemblies. When a top level assembly is grouped, the group icons 
of its sub-assemblies are greyed-out. You can still click the 

greyed-out icons to group or ungroup items that are nested within 
parent groups. 

The  icon is displayed in the Project Tree beside ungrouped 

assemblies. When assemblies are ungrouped, you can select their 
individual components separately. 
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Lay on surface 

Use the Lay on Surface  tool to move a component around the 

surface of a model. In ArtCAM Pro and ArtCAM Jewelsmith 2015 R2 

you can now click and drag grouped components (see page 9) as 

one object. For example, if you click and drag a gem, every item 

that is grouped under the same parent as that gem is dragged as 
one. Previously, you had to hold down the Shift key while dragging 

to move a component and all items sharing the same parent. 

If you want to move items individually, click the grouped  icon to 

ungroup assembly items in the Project Tree. 
 



 

ArtCAM 2015 R2 What's New What's New in ArtCAM 2015 R2 • 11  

Batch assemblies 

In ArtCAM Pro and ArtCAM Jewelsmith, there is a new Batch 

Assembly  button on the Assembly panel, which enables you to 

create multiple copies of an assembly. This can be useful if you 

want to print multiple copies of a model in the same 3D-printing 

job. 

The Batch Assembly tool is similar to the Block Copy  tool, but 

only one item is created in the Project Tree no matter how many 

copies you create. This makes the Project Tree much more 

manageable. In addition, you can continue to make changes to your 
assembly after creating a Batch Assembly, and these changes are 

automatically made to each copy. For example, if you use the 
Transform tool to scale the size of your assembly, the transform 

bounding box is drawn only around the original assembly, but each 
copy is scaled concurrently with the original.  

File sizes for exported batch assemblies are much smaller than file 
sizes for the same number of copies created by Block Copy because 

ArtCAM saves only one copy instead of saving data for each copy. 

To create a batch assembly for 3D-printing: 

1 Import or create an assembly. 

 

2 In the Project Tree, select the root Assembly  item to display 

the Assembly panel below the splitter bar.  
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3 On the Assembly panel, click Batch Assembly . A Batch 

Assembly  item is created in the Project Tree below your 

assembly. 

 

4 Drag the assembly  and drop it onto the Batch Assembly  

item to add it to the batch assembly. 

 

5 Select the Batch Assembly  item to display its panel below the 

splitter bar. 
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6 Click Create New 3D Print Job  to create a 3D Printing Job  

item within the batch assembly.  

 

7 Use the settings on the 3D Printing Job (see page 18) panel to 

create supports for your model. 

8 Select the Batch Assembly  item in the Project Tree to display 

its panel below the splitter bar. 

9 In the Layout area: 

 Select 2D Block to create one layer of copies. 

 Select 3D Block to create multiple layers of copies. 

10 Click Edit to display the Number and Spacing fields.  

 

a In the Number fields, enter the number of meshes you want in 

the X, Y, and Z directions. The Z field is available only if you 
have 3D Block selected. 

b In the Spacing fields, enter the distance between each mesh 
in the X, Y, and Z directions. The Z field is available only if you 

have 3D Block selected. 
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In this example the batch assembly is laid out in a 2D Block, with 

3 meshes in X and Y, and a spacing of 1 between each one. 

 

11 If you are creating a batch assembly for 3D-printing, it can be 
beneficial to have the bases of the copies join together so that all 
the copies are on one base. To do this: 

a In the Layout area, reduce the X and Y Spacing values to 0. 

This removes the spacing between the bases, but causes the 
copies to touch, which is not ideal. 
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b In the 3D Printing Job panel, increase the Border thickness 

value until there is adequate room around each copy.  

 

12 To export the copies as one 3D-printing job, right-click the Batch 

Assembly item to display its context menu and select 3D Print. 
The 3D Print panel (see page 30) is displayed. 

13 On the 3D Print panel, select your printer and export your batch 

assembly. For more information on the settings available on this 
panel, refer to the Reference Help. 
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3D-printing reliefs and assemblies 
In all variants of ArtCAM, you can now prepare reliefs for 3D 

printing (see page 16). In ArtCAM Pro and ArtCAM Jewelsmith only, 

you can also prepare assemblies for 3D printing (see page 18).  

 
 

3D-printing reliefs 

In ArtCAM 2015 R2, you can export any relief or relief layer for 
3D-printing. ArtCAM can export reliefs as .tar.gz files, which are 

compatible with the Ember printer, or .stl files, which are compatible 

with many other printers. If you do not own a 3D printer, you can 
export your relief to .stl, and then search on the internet to find a 

3D-printer local to you.  

 You must ensure your model dimensions do not exceed the 
build volume of your printer. 

You can export reliefs from the Front Relief or Back Relief layer 

stack, but ArtCAM ignores any negative heights, meaning the relief 
always has a flat base. This flat base means that the relief is stable 
enough to be printed without supports. 

 Relief layers are available only in ArtCAM Pro and ArtCAM 

Jewelsmith. 

To prepare your relief for printing in ArtCAM Insignia, ArtCAM Pro, 
or ArtCAM Jewelsmith: 

1 Ensure the relief you want to print is visible. 

2 Click Print Relief  on the Relief Layers panel. The 3D Print 

panel is displayed. 
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3 Select your printer: 

Ember Printer — Select to display the Ember Printing panel and 

export the relief as a .tar.gz file. 

 

a Click Browse and then navigate to the location in which you 

want to save the exported file. 

b Click Select Print Settings to display the Print Settings Selector 

panel. These settings provide the printer with information, 
such as layer thickness, and relate to the material you are 
using. You can use the default print settings provided by 
ArtCAM, or you can create your own. For more information, 
see the Reference Help. 

c After you select your print settings, the Printing Information 

area is added to the panel. This area displays the number of 

slices in which the relief will be printed. 
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d Click Export to Printer to export your relief to a .tar.gz file. 

 If your model exceeds the dimensions supported by the 

Ember printer, 64x40x134mm, an error message is 

displayed and your model is not exported. 

Local STL Printer — Select to display the Local STL Printer panel 

and export the relief as an .stl file.  

 

a Click Browse and then navigate to the location in which you 

want to save the exported file. 

b The relief must be triangulated in order to export it to an .stl 

file. In the Tolerance field, enter a tolerance to specify how 

closely the triangulation must stay to the relief. The lower the 
value, the more accurate the triangulation is, but increased 
accuracy means the process is slower. 

c Click Export to export the relief to an .stl file. 

 If you are working with ArtCAM Express, select File > Print 

Relief to print your relief. 
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3D-printing assemblies 

In ArtCAM Pro and ArtCAM Jewelsmith 2015 R2, you can prepare 

assemblies for 3D printing.  

Before you print certain assemblies, such as rings, you must create 

supports so that the assembly does not move. These supports 

attach the assembly to a base and keep it stable while it is being 

printed, and then must be manually removed after printing.  

To prepare an assembly that requires supports for printing, use the 
settings on the 3D Printing Job panel. Click Create New 3D Print Job 

 on the Assembly panel to create a Printing Job  item in the 

Project Tree, then select this item to display the 3D Printing Job 

panel. 

 

The locations of the supports are determined by contact points, 
which you can add to your assembly manually, or generate 
automatically. 

To automatically generate contact points and supports, click: 

  Create Supports (see page 20) to generate contact points 

and supports in one action; or 

  Create a Contact Point Group (see page 24) to generate 

contact points first, then generate supports. 

You can also manually edit or create support types (see page 34), 

position your contact points (see page 36), and edit the position of 

the generated supports (see page 39). 
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Some assemblies can be printed without the need for supports to 

hold them in place. If you want to prepare an assembly for 3D 

printing without creating supports (see page 30), right-click the 
assembly in the Project Tree and select 3D Print. This displays the 

3D Print panel, which enables you to select your printer and export 

your assembly to an .stl or .tar.gz file. 

 
 

Using the Create Supports button 

To prepare a model for 3D printing using the Create Supports button 

in ArtCAM Pro and ArtCAM Jewelsmith: 

1 Import or create a mesh, component, or assembly. 

 

2 In the Project Tree, select the Assembly item to display the 

Assembly panel below the splitter bar. 

3 Click Create New 3D Print Job . A 3D Printing Job  item is 

created in the Project Tree below the Assembly item. 
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4 Select the 3D Printing Job  item to display the 3D Printing Job 

panel. 

 

5 When supports are generated, a base is created. The base must 

be thick enough to support the part, and there must be space for 
supports between the bottom of the part and the top of the base.  

a Enter a value in the Distance from base to bottom field. If the 

distance is too small, the supports are not created. 

b Enter a value in the Base thickness field. 

c If you want to increase the size of the base around the model, 
enter a value in the Border thickness field. 

Border 

thickness of 0 
mm 

 

Border thickness 

of 2 mm 
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6 Click Create Supports . The Create Supports panel is 

displayed. 

 

7 You must select a support type so that ArtCAM knows what type 
of support to generate. Click Select Support Type to display the 

Support Type Selector panel. This panel contains the default 

support types and any custom support types you have created. If 

you want to add or edit any support types (see page 34), click 
Edit Library to display the Support Library panel. 

 

8 Select the support type you want to generate. The selected 
support type is displayed in the Support Type area of the Create 

Supports panel. 
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9 Click Create Supports. ArtCAM generates contact points on the 

model, then generates the supports from these contact points. 

 

In the Project Tree, a Contact Point Group item is created under 
the 3D Printing Job item. 

 

 If supports are not generated at the bottom of the part, 
increase the Distance from base to bottom value in the 3D 

Printing Job panel to give the supports more space, then 

click  on the Contact Point Group panel to regenerate 

the supports. 
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10 If the supports are not in the correct place, you can edit the 

position of the contact points or delete individual supports (see 

page 39) until you are happy with their position. 

11 When the supports are in the correct position, select the 3D 

Printing Job item in the Project Tree to display the 3D Printing Job 

panel. 

12 Click 3D Print  to display the 3D Print panel. 

 

13 Select which printer you want to use and export your model: 

 Ember Printer — If you have an Ember printer, select this 
option to display the Ember Printing panel and export your 

model as a .tar.gz file. 

 Local STL Printer — If you have an STL printer, or want to 

send the files to an STL printer in your local area, select this 
option to display the Local STL Printer panel and export your 

model as an .stl file. 
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Using the Create Contact Point Group button 

To prepare a model for 3D printing using the Create Contact Point 

Group button in ArtCAM Pro and ArtCAM Jewelsmith: 

1 Import or create a mesh, component, or assembly. 

 

2 In the Project Tree, select the Assembly item to display the 

Assembly panel below the splitter bar. 

3 Click Create New 3D Print Job . A 3D Printing Job  item is 
created in the Project Tree below the Assembly item. 

 

4 Select the 3D Printing Job  item to display the 3D Printing Job 

panel. 
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5 When supports are generated, a base is created. The base must 

be thick enough to support the part, and there must be space for 

supports between the bottom of the part and the top of the base.  

a Enter a value in the Distance from base to bottom field. If the 

distance is too small, the supports are not created. 

b Enter a value in the Base thickness field. 

c If you want to increase the size of the base around the model, 
enter a value in the Border thickness field. 

Border 
thickness of 0 

mm 

 

Border thickness 
of 2 mm 

 

6 Click Create a Contact Point Group . A Contact Point Group 
item (see page 37) is added below the 3D Printing Job item. You 

can create as many contact point groups as you like, and each 

group is assigned a different colour.  
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7 Select the Contact Point Group item to display its panel. 

 

8 You must select a support type before generating contact points. 
Click Select Support Type to display the Support Type Selector 

panel. This panel contains the default support types and any 
custom support types you have created. If you want to add or 
edit any support types (see page 34), click Edit Library to display 

the Support Library panel.  

 

9 Select the support type you want to generate. The selected 
support type is displayed in the Support Type area of the Contact 

Point Group panel. 
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10 You can now create the contact points. Click Automatically 

Generate Contact Points . Contact points are generated on 

the mesh in the colour assigned to the Contact Point Group item 

in the Project Tree. Contact points determine where the supports 

attach to the mesh. If they are not in the correct position, you 

can edit them or position them manually (see page 36).  

 

11 When the contact points are positioned where you want, click 

Generate Supports . ArtCAM generates the supports and 

creates a base for the supports to attach to. In the Project Tree, 
an individual mesh item is created for each support and the 
base. The supports are added to the Contact Point Group 

containing the contact points that they were generated from. 
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In the View window, you can see how the model looks with 

supports and a base generated. 

 

 If supports are not generated at the bottom of the mesh, 
increase the Distance from base to bottom value in the 3D 

Printing Job panel to give the supports more space, then 

click  on the Contact Point Group panel to regenerate 

the supports. 

12 If the supports are not in the right place, you can edit the 
position of the contact points or delete individual supports (see 
page 39) until you are happy with their position. 

13 When the supports are in the correct position, select the 3D 

Printing Job item in the Project Tree to display the 3D Printing Job 

panel. 

14 Click 3D Print  to display the 3D Print panel. 

 

15 Select which printer you want to use, then export your model: 
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 Ember Printer — If you have an Ember printer, select this 

option to display the Ember Printing panel and export your 

model as a .tar.gz file. 

 Local STL Printer — If you have an STL printer, or want to 

send the files to an STL printer in your local area, select this 
option to display the Local STL Printer panel and export your 

model as an .stl file. 
 

Using the 3D Print panel to export assemblies for 
3D-printing 

In ArtCAM Pro and ArtCAM Jewelsmith, you can quickly and easily 
export assemblies for 3D-printing using the 3D Print panel. Use this 

method if your assembly does not require supports to keep it in 

place during the printing process, for example, if it has a flat base.  

You can choose to export any assembly or sub-assembly for 
3D-printing, or export everything contained within the top level 
Assembly item. 

To export an assembly or sub-assembly for 3D-printing using the 3D 

Print panel: 

1 Ensure the components you want to export are visible. 

2 In the Project Tree, right-click the assembly item you want to 
export, then select 3D Print from the context menu. The 3D Print 

panel is displayed. 

 

3 Select which printer you want to use and export your assembly: 
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 Ember Printer — Select to display the Ember Printing panel and 

export your assembly as a .tar.gz file. 

 

a Click Browse and then navigate to the location in which you 

want to save the exported file. 

b Click Select Print Settings to display the Print Settings Selector 

panel. These settings provide the printer with information, 
such as layer thickness, and relate to the material you are 
using. You can use the default print settings provided by 
ArtCAM, or you can create your own. For more information, 
see the Reference Help. 

c After you select your print settings, the Printing Information 

area is added to the panel. This area displays the number of 
slices in which the relief will be printed. 

 

d Click Export to Printer to export your relief to a .tar.gz file. 
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 If your model exceeds the dimensions supported by the 

Ember printer, 64x40x134mm, an error message is 

displayed and your model is not exported. 

 Local STL Printer — Select to display the Local STL Printer 

panel and export your assembly as an .stl file. 

 

a Click Browse and then navigate to the location in which you 

want to save the exported file. 

b Click Export to export the relief to an .stl file. 

To export everything under the top level Assembly item in the 
Project Tree for 3D-printing using the 3D Print panel:  

1 Ensure the items you want to export are visible. 

2 Select File > 3D Print > Print Project. The 3D Print panel is 

displayed. 

 

3 Select which printer you want to use and export your assembly: 
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 Ember Printer — Select to display the Ember Printing panel and 

export your assembly as a .tar.gz file. 

 

a Click Browse and then navigate to the location in which you 

want to save the exported file. 

b Click Select Print Settings to display the Print Settings Selector 

panel. These settings provide the printer with information, 
such as layer thickness, and relate to the material you are 
using. You can use the default print settings provided by 
ArtCAM, or you can create your own. For more information, 
see the Reference Help. 

c After you select your print settings, the Printing Information 

area is added to the panel. This area displays the number of 
slices in which the relief will be printed. 

 

d Click Export to Printer to export your relief to a .tar.gz file. 
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 If your model exceeds the dimensions supported by the 

Ember printer, 64x40x134mm, an error message is 

displayed and your model is not exported. 

 Local STL Printer — Select to display the Local STL Printer 

panel and export your assembly as an .stl file. 

 

a Click Browse and then navigate to the location in which you 

want to save the exported file. 

b Click Export to export the relief to an .stl file. 
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Editing support types 

You can create new support types using the Support Library panel, 

and then edit their parameters using the Support Parameter Editing 

panel, or edit the default support types supplied with ArtCAM. 

Creating a new support type 

To create a new support type: 

1 In the 3D Printing Job panel, click Support Library  to display 

the Support Library panel. 

 

The Support Library is divided into sections, and each section has 

a New File  button.  

2 Click the New File button in the section to which you want to add 

the support type. A support type called New File is created. 

 To rename a support type, right-click it and select Rename. 
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Editing the parameters of support types 

To edit the parameters of the support types: 

1 In the 3D Printing Job panel, click Support Library  to display 

the Support Library panel. 

2 In the Support Library panel, select the support type that you 

want to edit. The Support Parameter Editing panel is displayed. 

 

3 Enter a description for the support type in the Description field. 

4 If you want to change the icon, click Change Icon. You can select 

a .png, .bmp, .jpg, or .gif file.  

5 Select an Editing Mode. There are two editing modes available: 
Basic and Advanced. The settings available for each mode are 

described in the Reference Help. 

6 Enter your parameters in the available fields, then click  to 

return to the library. 
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Manually positioning and editing contact points 

Contact points determine where supports attach to the assembly. 

They can be generated automatically, or positioned manually. 

Automatically generated contact points can be edited in the same 

way as manually positioned contact points. The colour of the contact 
points is determined by the colour assigned to their Contact Point 

Group. 

To manually position contact points, or edit contact points that have 

been automatically generated: 

1 On the Contact Point Group panel, click Modify Contact Points 

.  

2 Click the assembly at the position you want to add a contact 

point. A contact point is created in the colour assigned to the 
selected Contact Point Group. 

3 Click a contact point to remove it from the part. If the contact 
point has a support, either: 

 Delete the support mesh from the the Project Tree; or  

 Click Generate Supports  to remove all supports and 

regenerate them. 
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Using contact point groups 

Contact points are grouped into Contact Point Groups in the Project 

Tree. You can add more than one contact point group to a 
3D-printing job. Each Contact Point Group you create is assigned a 

different colour, which makes it easier to see to which groups the 

contact points on the assembly belong.  

 

To change the colour of the points in a group, click the colour 
swatch beside a Contact Point Group item to display the Color dialog 

and select a new colour.  

You can select a different support type for each Contact Point Group. 

For example, if you want to have column supports at the bottom of 
the model, and tree supports at the top of the model, you can 
create two contact point groups and select a different support type 
for each before manually adding your contact points to the model. 

In this example, column supports are used to attach the bottom of 
the model to the base, and tree supports are used to support the 
top of the model. 
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Editing the position of generated supports 

After you have generated the supports for your assembly, you can 

delete any that you do not want before exporting the files to the 

printer. 

To delete supports: 

1 In the View window, click the support you want to remove. The 

corresponding mesh item is highlighted in the Project Tree. 

 Ensure the Contact Point Group containing that mesh is 

expanded so you can see which mesh is highlighted. 

2 Right-click the highlighted mesh and select Delete from the 

context menu. 
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Print Settings Library 

When using the Ember printer, you must define the print settings to 

tell the printer how you want to print the relief. Different resins and 

slice thicknesses need different parameters specified in order to 
print successfully. Use the Print Settings Library panel to select one 

of the default settings files, or create your own.  

 

To display the Print Settings Library panel: 

 If you are printing a relief, select File > 3D Print > Print Settings 

Library, 

 If you are printing an assembly, click Print Settings Library  
on the 3D Printing Job panel. 

The following settings are available: 

New Section — Click this button to create a new section beneath the 

existing sections in the panel. The new section contains a blank New 
File icon. To rename the section, right-click its header and select 
Rename. 

 New File — There is a New File button in each section. Click 

this icon to create a new support type.  

 Print Settings icons — Click a print settings icon to display the 

Print Settings Editing panel, where you can edit the parameters of 

the selected print settings type. For more information about the 

available parameters, see the Reference Help. 
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Using the Draw Bitmap Line tool 

The Draw Bitmap Line  tool enables you to draw a bitmap line 

on the active bitmap layer in the primary or secondary colour. This 
tool now works in the 3D View window as well as the 2D View 

window. You can control the thickness and shape of the line using 
the slider on the new Tool Settings: Line Tool panel, which is 

displayed when you click the  button. Previously you had to 
use the Tool Settings: Paint Tool panel to control the line thickness 

and brush shape. 
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Identifying snap points 
There is a new Snap Hints option in the View > Snapping menu.  

 

When this option is selected, small circles appear at potential snap 

points as the cursor moves near them, which helps you to locate 

hard-to-find snap points. Some already visually obvious snap 
points, such as vector intersections, are omitted. In the event that 
there are many potential snap points in close proximity to the 

cursor, their number is limited to the closest 20 snap points. 

In the following example, you can see the potential snap points as 

black circles on the vector artwork above the cursor . 
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Changing the thickness of vectors 
You can now change the thickness of vectors in both the 2D View 

and 3D View windows. Previously it was only possible to change the 

thickness of vectors in the 3D View window.  

To change the thickness of the vectors in your model: 

1 Select Edit > Options to display the Options panel. 

2 Click Drawing Options to expand the area and display the 

available settings. 

 

3 In the Vector Thickness field, enter the width of your vectors in 

pixels.  

4 Click Apply. The thickness of all vectors in the model is updated 

the new value. 
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Creating fillets 
There are new fillet settings available from the Tool Settings: Fillet 

Vectors panel, which give you more flexibility when creating 

rounded corners, closing vectors, or joining vectors. In addition, the 

Fillet Vectors  button is updated to keep it consistent with the 

icons on the panel. 

 

You can now create the following fillets: 

Fillet arc — This option replaces the Insert Fillet option. Enter a 

radius for the fillet in the Radius Fillet field, then either click the line 

spans you want to join with an arc, or click the corner you want to 
smooth. 

 

Dog bone — This option enables you to create an arc on corners. 

This fillet needs two adjacent lines to work. Enter a radius in the 
Radius Fillet field, then click the corner at which you want to insert 

the arc. 
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T bone — This option enables you to create an arc to one side of a 

corner. The fillet needs two adjacent lines to work. Enter a radius in 
the Radius Fillet field, then click the two adjacent line spans you 

want to join with an arc. The arc is created on the first line span 

clicked.  

 

External arc — This option extends adjacent line spans tangentially 

and then loops back round. You could use this fillet for smooth 

rather than abrupt changes in direction. 

 

Extend/trim line to intersection — This option is unchanged in ArtCAM 

2015 R2. 
 



 

46 • What's New in ArtCAM 2015 R2 ArtCAM 2015 R2 What's New  

Exporting true circles 
There is a new Output true geometry setting on the Options panel. If 

selected, when you export circles to a .dgk or .dxf file, you export 

them as their true shape instead of as arcs or Bézier curves. This 

can lead to better machining results because some machines use 

circle data when machining. 
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Merging vector layers 
You can now merge multiple vector layers when they are selected in 

the Project Tree. Previously, you could only merge vector layers 

that were visible. 

 If you are working in ArtCAM Express, vector layers are 
available only with the Vector Tools module. 

To merge selected vector layers: 

1 In the Project Tree, select the vector layers that you want to 
merge. The Vector Layers panel is displayed below the splitter 

bar. 

 

 Press and hold down the Shift key to select multiple layers. 
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2 Click Merge Vector Layers . The selected layers are combined 

into one new layer called Merged Layer 1. 
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Importing and exporting vectors 
There are new import options available when working with vector 

layers. 

 If you are working in ArtCAM Express, vector layers are 
available only with the Vector Tools module. 

On the Vector Layers panel, the Import Vectors button is replaced by 

the following buttons: 

  Import Vectors Preserving Layers — This is the same as 

selecting Vectors > Import on the Main menu bar. If layers are 

detected in the file, a new vector layer is created for each layer.  

  Import Vectors Into New Layer — This is the same as 

selecting Vectors > Load Layer on the Main menu bar. Click to 

import all vectors in the file into a single new layer regardless of 

how many layers are in the file. 

There is a new Export option on the Vectors  item context menu, 

which is the same as selecting Vectors > Export on the Main menu 

bar and enables you to export all vectors in the model. The context 
menu also contains the two new import options: Import Preserving 

Layers and Import Vectors Into New Layer. 

 

On the panel that is displayed when you select a vector layer in the 
Project Tree, the Import Vectors button is replaced by the following 

buttons: 

  Import Vectors Preserving Layers — This is the same as 

selecting Vectors > Import on the Main menu bar. If layers are 

detected in the file, a new vector layer is created for each layer.  
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  Import Vectors Into New Layers — This is the same as 

selecting Vectors > Load Layer on the Main menu bar. Click to 

import all vectors in the file into a single new layer regardless of 

how many layers are in the file. 

  Import Vectors Into Layer — Click to import vectors into the 

currently selected layer. 

These options are also included in the vector layer's context menu. 

 

When you have multiple vector layers selected, a new Export  

button is available on the Vector Layers panel. Click to export all 

selected vector layers to one file. This option is also available from 
the context menu.  
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Preserving vector colour information 
There is a new Split colours into separate layers option on the Options 

panel, which enables you to choose whether or not differently 

coloured vectors are imported onto different vector layers.  

 

 If you are working in ArtCAM Express, vector layers are 
available only with the Vector Tools module. 

If Split colours into separate layers is selected, when you use Import 

Preserving Vector Layers (see page 48)  to import a .dxf file 

that contains different coloured vectors, the coloured vectors are 
imported into separate layers so that you do not lose the colour 
information. If Split colours into separate layers is deselected, colour 

information is lost if there are layers containing vectors with 
different colours. This option is deselected by default. 

For example, this .dxf file, as viewed in Delcam Exchange, contains 

a single layer with multiple colours: 
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If you import it into ArtCAM using Import Preserving Vector Layers 

(see page 48) , the colours are preserved and imported into 

two separate layers: 
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Using rulers in the 3D View window 
Rulers are now displayed by default in the 3D View window. The 

rulers are attached to the top and left edge of the model area, and 

move with the model as you rotate and reposition it. 

 

Rulers are displayed by default. If you want to hide the rulers, 
deselect View > Show Rulers. This hides the rulers in both the 2D 

View window and the 3D View window. 

To change the colour of the ruler in the 3D View window: 

1 Select Edit > Options to display the Options panel. 

2 Expand the Drawing Colours section. 

3 In the 3D Drawing Colours area, click the Rulers colour swatch to 

display the Color dialog. 

4 Select a new colour and click OK. 

5 On the Options panel, click Apply. 
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Creating relief layer groups 
In ArtCAM Pro and ArtCAM Jewelsmith, you can now create relief 
groups in the Front Relief and Back Relief layer stacks. Relief groups 

can contain multiple relief layers and other relief groups. 

 

Relief groups give you much more control over how relief layers 
combine with the composite relief. You can use each item's combine 
mode to control how the layers within relief groups combine with 
each other, then control how the relief group as a whole combines 
with the Relief Layer stack by changing its combine mode and its 

position in the stack. 

To create a relief group, click the New Relief Layer Group  
button, either on the Relief Layers panel or on a selected layer's 

panel. The new relief group is created above the previously active 

relief layer in the layer stack. You can drag it to change its position 

in the layer stack or drop it into another relief group. 

To add relief layers to a relief group, select the relief group in the 

Project Tree, and click New Relief Layer  in the relief group's 

panel. The new relief layer is added above the active layer. 

Alternatively, you can drag and drop existing layers onto relief 

groups to add them. 
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Interactively editing the Z height of 
relief clipart 

When you are using the Transform tool and your selection includes 

relief clipart, a control arrow  pointing in the Z direction is 

displayed. Click and drag this arrow to resize all selected relief 

clipart in the Z direction. This tool enables you to interactively blend 

heights with another relief or relief clipart. 
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Exporting relief slices to .dxf 
In ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith, the Slice 

Relief  tool enables you to divide the composite relief or the 

content of a single relief layer into slices. When you use the Slice 

Relief tool, you can now export relief slices to .dxf files, which can be 

useful for creating outlines for Laser Machining. 
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Sharing your Relief Height Analysis 
settings 

In ArtCAM Pro and ArtCAM Jewelsmith, there are new Export 

Settings and Import Settings buttons available in the Relief Height 

Analysis area of the 3D Graphics Options panel. These buttons 

enable you to share your relief height analysis settings between 

workstations, meaning you only need to set up your colours and 

heights once.  
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Using the Texture Flow tool 

The Texture Flow  tool enables you to paste consecutive copies 

of relief clipart on a path within a boundary. In ArtCAM Pro and 

ArtCAM Jewelsmith 2015 R2, you can choose to keep the generated 

texture relief clipart as relief clipart rather than pasting it directly 

onto the active relief layer.  

The Paste Options area replaces the Boundary Options area, and 

contains the new Relief clipart pasting options: 

 

Paste — The relief clipart is pasted onto the active relief layer. You 

can choose any of the Clipping Style options. This matches the 

previous behaviour of the tool. 

In this example, Paste is selected with the Keep Clipping Style: 

 

Do not paste — The relief clipart is kept as individual pieces of relief 

clipart. You can select a Keep or Delete Clipping Style. 
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In this example, Do not paste is selected with the Keep Clipping 

Style: 

 

Only paste inside — Any pieces of relief clipart that lay inside the 

boundary are pasted onto the relief layer. Relief clipart that 
intersects the boundary is kept as relief clipart. 

In this example, Only paste inside is selected: 

 

If you have a vector or group of vectors selected with Set Object, 
the Relief clipart pasting options are unavailable. You can choose any 

of the Clipping Style options. This matches the previous behaviour of 

the tool. 
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In this example, the Keep Clipping Style is selected: 
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Live tools 
Three tools now work in real-time, meaning you see instant results 

when you manipulate the vectors. 

  Two Rail Ring Sweep (see page 61)  

  Weave (see page 63)  

  Contour Blend (see page 66)  
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Live Two Rail Ring Sweep tool 

When you use the Two Rail Ring Sweep tool in ArtCAM Jewelsmith, 

the relief updates in real-time so you can instantly see the results of 

any adjustments you make to the vectors.  

 

In addition, there are the following changes to the panel: 

 The panel is redesigned so it is consistent with the Two Rail 

Sweep panel. 

 When you display the panel, it is now docked on the right hand 
side of the View window. 

 The Set Ring Silhouette option replaces the Ring Silhouette option, 

and is located in the Height Controls area of the panel. 

 The Silhouette Vector Controls Z option is removed. If a ring 

silhouette is selected, it is implied that this vector controls the Z 

height.  
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Live Weave tool 

In ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith, the Tool 

Settings: Weave Tool panel replaces the Weave Wizard dialog. This 

tool now works in real-time so you can instantly see results when 

you manipulate the drive rail or cross-section vectors. 

 

There are two new buttons, Set Drive Rails and Set Cross Section, 

which give you greater flexibility when selecting vectors because 

you can now select vectors after opening the tool. Previously, you 

had to select your vectors before opening the tool, and the order in 

which they were selected determined whether a vector was a drive 

rail or a cross-section.  

To create a weave relief: 

1 Display the 3D View window. 

2 In the Relief Creation toolbar, click Weave . The Tool 

Settings: Weave Tool panel is displayed. 
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3 Select the vectors you want to use as drive rails then click Set 

Drive Rails. An A is displayed beside the start point of all drive 

rails, and arrows indicate the direction of the vectors. 

 

4 Select the vector you want to use as the cross-section then click 
Set Cross Section. A Z is displayed beside the start point of the 

cross-section vector. 
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A preview of the relief is displayed in the 3D View window. 

 

5 In the 3D View window, select a vector and edit the nodes to 

change the shape of the weave. The relief preview updates 
instantly as you make your changes. 
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6 Edit the parameters in the Crossing Options area of the panel to 

control how the crossovers are displayed. 

7 In the Relief Combine Mode area, choose how the relief combines 

with the active relief layer. 

8 When you have finished making adjustments to the appearance 
of the weave, click Apply. 

 If you close the panel without clicking Apply, or click Cancel, 

the relief is reset. However, any changes you made to the 

vectors are retained. 
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Live Contour Blend tool 

When you use the Contour Blend  tool in ArtCAM Pro and 

ArtCAM Jewelsmith, the relief is updated in real-time so you can 

instantly see the results of any adjustments you make to the 
vectors. In addition, the Contour Blend panel is now a Tool Settings 

panel, so is docked on the right-hand side of the View window when 

it is displayed. 
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Creating constant height letters 
In ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith, you can 
now use the Shape Editor to create constant height letters. The 

Constant Height Letters button is removed from the Relief Creation 

toolbar, and a Corner Angle field is added to the Shape Editor panel. 

 

To create constant height letters with the Shape Editor: 

1 Select the vector text from which you want to create the reliefs. 

2 In the Relief Creation toolbar, click Shape Editor  to display 

the Shape Editor panel. 

3 Select a Round or Square profile. 

4 Select Constant height. 

5 In the Height field, enter the height of the profile. This is the 

equivalent of the Top Height field in the old workflow. 

6 In the Corner Angle field, enter the radius of the corners in the 

lettering. This enables you to taper all areas of the constant 
height relief that are of a smaller radius than that specified. 

7 In the Start Height field, enter a height for the base of the letters. 

This is equivalent to the Bottom Height field in the old workflow. 

8 Click Apply to create the relief. 
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Searching the libraries 
There is new search field in the Vector Library, Relief Clipart Library, 

and Component Library panels, which enables you to quickly find 

files saved in the library you are searching in. When you enter a 

search term in the field, the top results appear while you type. 

 The Component Library is available only with ArtCAM 

Jewelsmith. 

 

You can use the wild card * character to search within a word. For 

example, typing *bea in the Relief Clipart Library search field returns 

any relief clipart with bea in its name. 
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To search for all clipart created on the day you're searching, enter 

created today in the search field. 

 

To exclude items from the search, enter not * in the search field in 

front of the term you want to exclude. For example, to search for all 

grape clipart, but exclude any whose name mentions vines, enter 

grape not *vine. 
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Controlling the direction of the offset in 
3D Offset strategies 

In ArtCAM Pro and ArtCAM Jewelsmith, when creating a 3D Offset or 

3D Offset Spiral Machine Relief toolpath, you can now choose 

whether to start offsetting from the inside or the outside of the 

clearance area. Previously these strategies only allowed you to start 

offsetting from the outside. 

For some customers, the Start Inside option can improve machining 

by reducing damage to the tool and to delicate materials (such as 

jewellery wax). 
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Setting a threshold for surface links in 
3D Offset and Constant Z strategies 

In ArtCAM Pro and ArtCAM Jewelsmith, there is a new Surface Links 

option when you are creating 3DOffset, 3DOffset Spiral, or Constant-Z 

finishing strategies. When Surface Links is selected, you can set a 

Threshold for surface links. If a link length is above the threshold, 

the toolpath safely retracts to Safe-Z; but if the link length is below 

the threshold, the tool link moves across the model surface to the 

next offset or slice. 

Surface link moves can significantly speed up some toolpaths by 

reducing the slow Z-axis retract and plunge moves. However this 

option must be used with care. Long surface link moves can go 

outside a machining boundary, but will still follow the model Z 

profile. So you must ensure that adequate material is removed by 

roughing. 
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Selecting multiple toolpaths 
You can now select multiple toolpaths from different parent groups 

and simulate or delete them. For example, if you have an Area 

Clearance toolpath containing three toolpaths, and a Profile 

toolpath, you can now select one of the Area Clearance toolpaths 

and the Profile toolpath, and then simulate them together. 

Previously, multiple selection was restricted to toolpaths within the 

same parent group.  

To select toolpaths from different parent groups, press and hold 
down the Ctrl key, then use the cursor to select from the Project 

Tree the toolpaths you want to simulate.  

 

Right-click a toolpath in your selection to display the context menu. 

This menu enables you to simulate or delete the selected toolpaths. 
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Simulating toolpaths 
In ArtCAM 2015 R2, toolpath simulation is much faster when you 

use the Simulate Toolpath  button, or select Simulate Toolpath 

or Simulate All Toolpaths from a context menu. Now, when you 

simulate toolpaths, ArtCAM splits the model up into blocks, and 

these multiple blocks are machined in parallel by the GPU/CPU. This 

means the simulation process looks different when you watch it. 

 

If you want to play through the simulation more slowly and view the 
wireframe tool moving across the model, click the Simulation Control 

Bar  button on the panel of the toolpath you want to simulate 

to display the Simulation Control toolbar.  

 

 For more information about the options on this toolbar, see 

the Reference Help. 
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Miscellaneous changes 
There are the following changes to ArtCAM which are not covered in 

previous topics: 

 The Tutorials tab supersedes the Live! tab so that all the latest 

tutorials and videos are available from one location.  

 The classic mode Toolpath and Layers panels are removed. All 
functionality is covered by the Project panel, which is where 

development is focused.  

 The ArtCAM Advantage option is removed from the Help menu. 

The same function is performed by the Help > Check for ArtCAM 

Updates > Software Updates option. 

 If you delete a toolpath from the Project Tree, you can now click 

Undo  or press Ctrl+Z to restore the deleted toolpath. 

 The Erase Bitmap  tool now works in the 3D View window as 

well as the 2D View window. 

 In the Options panel: 

 The 2D Drawing Options area is renamed to Drawing Options. 

 The Align Nodes - replace with single line option is now in the 
Miscellaneous area. 

 The Vector Thickness field is added to the Drawing Options 
area. Previously this option was located on the 3D Graphics 

Options panel. 

 There is a new Open on double-click option under the Relief 

Modelling area of the Options panel, which is selected by 
default. When selected, the Shape Editor panel is displayed 

when you double-click a vector. Deselect this option to disable 

this behaviour. 

 There is a new Use GPU for selection option under the 
Offscreen Rendering area of the Options panel, which is 

selected by default. If antialiasing is forced on in the graphics 

driver, this causes an incompatibility with this option which 

can adversely affect the selection of nodes or relief clipart in 
the 3D View window. If this happens, deselect this option or 

turn off antialiasing. 
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 The options from the Tool Settings: Node Editing panel are now 

also available from the bottom of the Tool Settings: Shape Editor 

Tool panel, so it is easier to edit nodes when working with the 

Shape Editor. 

 

 The Sweep Profile  tool is removed from the Rotary Relief 

Tools toolbar in ArtCAM Jewelsmith because you can create 

simple swept profiles using the Two Rail Ring Sweep  tool. 
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